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Figure 1: About nomacs. 

1. Features 

nomacs is a free image viewer for Windows, Linux – and lately also Apple Mac systems. 

nomacs is small, fast and able to handle the most common image formats. 

1.1. Overview 
 Available in three languages as yet: English, German, Russian (cf. 2.2.1.1). 

 Supports most common image formats 
 

File Extension Read Write Comment 

jpg x x  

png x x  

tif x x  

bmp x x  

ppm x x  

xbm x x  

xpm x x  

gif x  no animations 

ico x  no scales 

pbm x   

pgm x   

nef x  colors not corrected 



crw x  colors not corrected 

cr2 x  colors not corrected 

arw x  colors not corrected 

jps x  no anaglyphs 

mpo x  just main frame 

 Displays exif information (cf. 2.2.1.4) 
 Fast thumbnail preview (cf. 2.3.1)  
 Drag and drop images 
 Automatically save screenshots 
 Synchronize multiple instances (cf. 2.4.1)  

- synchronized zooming 
- synchronized panning 
- synchronized next/previous file 
- overlay of two or more instances (with changing opacity) 
- arrange synchronized instances 

 Synchronize multiple instances in the LAN (cf. 2.4.2)  

- synchronized zooming 
- synchronized panning 
- images can be sent over LAN connection 

 Change transparency of windows (cf. 2.3.4)  
 Slideshow 

- image information (e.g. date created) 
- play/pause with user defined time interval 
- adjustable background color 

 Hide menu bar and toolbar 
 Display overview while zooming (cf. 2.3.2)  
 Resize images 
 Rotate images 

2. Main Menus 

2.1. File Menu 
Provides standard file handling functions. 



 

Figure 2: File Menu. 

Several instances of the viewer can be running at the same time. As a special nomacs feature these 
instances can be synchronised with each other, panned, zoomed, overlaid, etc. (cf. 2.4.1). 

2.2. Edit Menu 
The Edit Menu allows rotating an image. Additionally the Settings Menu can be edited (cf. 2.2.1). 

 

Figure 3: Edit Menu. 

Screenshots can be pasted easily [Ctrl+V] and saved to any supported image format. 

2.2.1. Settings Menu 
As described in the Edit Menu, Settings allows defining the standard settings of the viewer. 



2.2.1.1. General Settings 

 

Figure 4: General Settings. 

Show Overview activates the overview panel if the current size of the image is larger than the viewing 
area of the image (depending on the image size and the zoom level).  

Invert Zoom defines if the image is scaled up or down, if the mouse wheel is turned in one direction.  

Keep Zoom apply the same zoom level if the Next or Previous file is loaded.  

Wrap Images loads the first image of a folder after the last image is reached.  

Thumbnails define the thumbnail size and allows to save the thumbnail within the exif data of an 
image. 

Choose language: nomacs is available in three languages as yet: English, German, Russian. Help us 
translate into further languages: http://www.nomacs.org/how-to-translate-nomacs/. 

http://www.nomacs.org/how-to-translate-nomacs/


2.2.1.2. Slideshow Settings 

 

Figure 5:Slideshow Settings. 

Display Time shows the time each picture is shown.  

Background Color allows the choice of a background color.  

Display Information defines the information that is shown for each image.  

2.2.1.3. Synchronize Settings 

 

Figure 6: Synchronize Settings. 

enable network sync allows LAN synchronization of viewers running on different computers.  

switch files defines if the next file in the current folder can be loaded (initiated by another viewer).  



send new images defines if an image send by another connected viewer is shown in the current 
viewer.  

control window position allows to set a new position of the viewer by another connected viewer.  

synchronize pan and zoom allows to apply a new transformation defined by another connected 
viewer to the current image (zoom, panning).  

2.2.1.4. Exif Settings 

Defines which information is shown in the metadata panel. 

nomacs can also show the exif Information of the camera (cf. 2.3.2). 

2.3. View Menu 

 

Figure 7: The View Menu. 

2.3.1. Toolbars 

define which menus are shown in the viewer. 

The Toolbar Toolbar includes 

 

Figure 8: The main toolbar. 



- Show Previous File 
- Show Next File 
- Open Directory 
- Open  
- Save 
- Rotate 90° Counter Clockwise 
- Rotate 90° Clockwise 
- Full Screen 
- Reset Canvas to fit Viewer 
- Show 100% 
- Show GPS Coordinates 

The Statusbar Toolbar at the bottom of the viewer show the I mage’s 

- x and y coordinates 
- RGB channel values 

2.3.2. Show Options 

2.3.2.1. Show Thumbnails 

shows a thumbnail preview of all images in the directory [T]. 

 

Figure 9: Thumbnails shown above the image. 

2.3.2.2. Show Metadata 

shows the image’s metadata at the bottom of the image [M]. 



 

Figure 10: Metadata at the bottom of the image. 

2.3.2.3. Show Overview 

enables an overview panel at the top left corner of the viewer [O]. 

 

Figure 11: Overview of the whole image in the upper left corner. 

2.3.2.4. Show Player 

shows the buttons of the slideshow player at the bottom of the image and thus turns the viewer into 
an actual slideshow player for image presentations of any kind [P]. 



 

Figure 12: Player buttons for Back, Play & Forward at the bottom of the image. 

 

2.3.2.5. Show File Info 

shows the buttons of the slideshow player at the bottom of the image [I]. 

2.3.2.6. Show Pseudocolorfunction  

shows the toolbar for the color contrast tool [Ctrl+G] (cf. 2.5). 

2.3.3. Screen Size and Zoom Options 

- Full Screen [F11] 
- Reset Canvas [Ctrl+0] 
- Show 100% [Ctrl+1] 
- Zoom In [Ctrl++] 
- Zoom Out [Ctrl+-] 

2.3.4. Transparency <> Opacity Options 

defines the transparency options of the viewer. This allows aligning different viewers. 

- Opacity Up [Ctrl+Shift+H] 
- Opacity Down [Ctrl+H] 
- Toggle Opacity [Alt+H] 



Figure 13: Transparency. 

2.4. Sync Menu 
Synchronize allows synchronizing several running instances of the viewer (on one computer). A list of 
all running viewers is shown in the menu, which can be selected to connect the viewer to the one in 
the list. 

LAN Synchronize allows synchronizing viewers running on different computers via LAN connection. 
This must be enabled in the Network Settings menu. A list of all viewers running as server is shown. 
Otherwise it is possible to activate the current viewer as a server. 

Synchronize View [Ctrl+D] applies the same view to all connected viewers. 

Window Overlay [Ctrl+Tab] positions the connected viewer at the same position as the current 
viewer. 

With the synchronization it is possible that multiple viewers perform the same action (like panning, 
zooming, etc.). This feature is useful when two images are compared. 

2.4.1. Synchronization on the Same Computer 
For synchronization on the same computer at least two viewers have to run. Via the “Synchronize”-
Menu it is possible to connect to all viewers or a specific viewer can be chosen by selecting the image 
title of this viewer. Additionally it is possible to connect two viewers by keeping the [Ctrl] and [Alt] 
key pressed and drag from the image of one viewer to the other. For actions which should be 
performed on all connected instances the [Alt] key has to be kept pressed (e.g. hold the [Alt] key 
pressed and use the mouse wheel for zooming on all connected viewers). 

Possible actions which can be performed: 

- Panning [Alt+mouse] 
- Zooming [Alt+mouse] 
- load next/previous File [Alt+right / Alt+left] 
- synchronize zoom level and position in the image with [Ctrl+D] 



- overlay the two images and change the opacity of one image with  [Ctrl+Tab] 
- arrange synchronized viewers with [Ctrl+Shift+Tab] 

2.4.2. Synchronization in the Local Network (LAN) 
To synchronize viewers via the local network one viewer has to start the server using the menu. The 
viewer on the other computer can then connect to the server. Additional to the actions on the same 
computer (see above) images can also be sent over the network by pressing ALT+I. 

In the settings dialog actions can be forbidden for all clients (cf. 2.2.1.3). 

Note: 

If a server connects to another server in the network, all clients of this server disconnect and 
establish a new connection to the target server. Also the server of the current viewer is stopped. 

2.5. Pseudocolor Function 
The pseudocolor function toolbar enables a color mapping. The toolbar is used to control the 

mapping between one color channel of the original (source) image and the manipulated (=pseudo 

color) image. 

 

Figure 14: Pseudocolor Function Toolbar. 

2.5.1. Usage 
The pseudocolor function is shown (respectively hidden) via Toolbars – Show Pseudocolorfunction or 

by pressing [Ctrl+G] (cf. 2.3.2). The toolbar (cf. Figure 14) can be positioned anywhere on the screen 

by clicking on the dotted line on the very left and pulling it to the favoured position, e.g. under the 

other toolbars, next to the nomacs viewer oder at the bottom of the viewer. 

Then check the checkbox Enable at the very left side to activate the false color toolbar. Uncheck and 

the original image reappears. 

A color channel of the loaded image can be selected in the drop down menu Active channel. For color 

images this menu contains four entries: 

- Red 
- Green 
- Blue 
- RGB (=an averaged version of the three color channels) 

In order to get a feel for the intended color enhancements it is advisable to select each color channel 

one by one and see which one works best for the given task. 

Hint: For UV fluorescence images of parchment the blue channel is advisable (in palimpsest cases the 

underscript is visible best). 

If the input image is a grayscale image, the dropdown menu contains a single entry: Gray.  



2.5.2. Color Bar and Sliders 
The color mapping is defined by the sliders in the color bar. The color bar is a color gradient with 

several sliders located below the rectangle. These sliders mark the color stops. In the starting 

position there are only two sliders, one on the very left (black) and one on the very right (white) side. 

The fill color of the slider denotes the assigned color. Sliders can be moved by dragging them 

horizontally. A slider is removed by dragging it downwards. A new slider can be inserted by simply 

clicking on the desired location in the gradient fill. 

The reset button on the right of the color bar restores the original settings and removes all slider 

modifications. 

The color picker button is a useful tool to emphasis a specific color (or color range) in an image. 

Choose a particular color in the image, i.e. add a slider exactly at that particular color, by clicking first 

on the color picker on the right (mouse cursor turns into a crosshairs cursor when moved over the 

image) and then on the according location/color in the loaded image. A new slider will appear in the 

color bar. The color selection process can be interrupted by pressing [ESC]. 

2.5.3. Step-by-Step Example 
For a more practical understanding a walk-through through an exemplary task will be given here. 

The aim is to emphasize the vertical text in the input image shown below: 

 

Figure 15: Input image (grayscale). 

The first step is to enable the pseudocolor function by clicking on Enable. The default color bar is 

given in Figure 16: 

 

Figure 16: Default color bar. 

In the next step, the color of the vertical text is selected by clicking on the color picker button and 

then clicking on an area belonging to the overwritten text. A new slider (middle) appears, cf. Figure 

17: 

 

Figure 17: Color bar with a new slider (2
nd

 position) at the color position of the underwritten text. 



By double clicking directly on the slider in the middle (that depicts the chosen color in the image) the 

color of this area can be changed. A dialog opens and a color can be picked, like e.g. green as shown 

in Figure 18. 

 

Figure 18: Color choice panel. 

 

This color also shows in the color bar (cf. Figure 19) and the image looks like in Figure 20. 

 

Figure 19: Color bar with selected color. 

 

Figure 20: Image with first false coloring. 

Add a new slider on the right side of the green slider by clicking into the color bar. Set the color of 

the new slider to black. The color bar should look similar to the one given in Figure 21. Move the new 

slider left and right to get a feeling for the color mapping. 

 

Figure 21: Second additional slider (3
rd

 position). 

In the ensuing step, we will add a red outline to the emphasized text. Therefore, insert a new slider 

between the green and the black slider. The color bar should resemble the one in Figure 22 and the 

image the one in Figure 23. 



 

Figure 22: Third new slider (3
rd

 position), color set to red. 

 

Figure 23: Image with additional red outlines in false color. 

In the last step we will increase the contrast of the vertical text to the horizontal text and the 

background. Therefore the white slider is moved to the left (cf. Figure 24). The result you can see in 

Figure 25. 

 

Figure 24: Contrast enhancement by moving white slider (5
th

 position) to the left. 

 

Figure 25: Final high contrast false color image. 

 

  



3. List of Shortcuts 
Ctrl+O Open file 

Ctrl+Shift+O Open Directory 

Ctrl+M Open With another program 

Ctrl+S Save 

Ctrl+P Print 

F5 Reload File 

Left Previous File 

Right Next File 

Ctrl+N Start New Instance 

Ctrl+F4 Exit 

Shift+R Rotate image 90° Counter 
Clockwise 

R Rotate image 90° Clockwise 

Ctrl+C Copy 

Ctrl+V Paste 

Del Delete 

Ctrl+T Resize Image 

C Crop Image 

0-5 Change Rating 

Ctrl+Shift+P Settings 

T Show Thumbnails 

M Show Metadata 

O Show Overview 

P Show Player 

Ctrl+L/F11 Full Screen 

Ctrl+0 Reset Canvas 

Ctrl+1 Show 100% 

Ctrl+2 Fit Window to Image 

F10 Toggle Frameless View 

Ctrl+G Show Pseudocolor Function 

Ctrl++ Zoom in 

Ctrl+- Zoom out 

Ctrl+Shift+H Opacity Up 

Ctrl+H Opacity Down 

Alt+H Toggle Opacity 

Ctrl+A Synchronize all Instances 

Ctrl+D Synchronize View 

Ctrl+Tab Window Overlay 

Ctrl+Shift+Tab Arrange synchronized Viewers 

Alt+mouse Synchronized Panning 

Alt+mouse Synchronized Zooming 

Alt+right Load Next File Synchronized 

Alt+left Load Previous File Synchronized 

ESC Stop color picker/Close 
Thumbnails/Close Exif Panel

 


